
Random Bits

Photo submitted by Robert Vance.

Swan feeding at Yoctangee Park. 

 Search for Yoctangee Park, 

Chillicothe, Ohio 45601 at 

http://maps.google.com/  Flag B 

appears to be the correct location. 

 Chillicothe apparently uses red 

light cameras.  You can find them 

by searching "red light camera 

45601".  Have a safe trip.
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FROM THE PRESIDENT

 

Jim Amore

I want to thank everyone for keeping involved with the 

computer society. We will be hosting the National APCUG 

convention in August and we will need help with little 

things during the convention. The one thing we are trying 

to set up is a spouse’s/family activity in our area. Some 

thoughts are going to Longaberger basket, Newark 

Earthworks / Great Circle Museum, Ye Olde Mill - Home 

of Velvet Ice Cream, The Mall, The Works, Heisey 

Museum, and Granville shops ect. Anyone willing to put 

together something and be able to set a price so we can 

offer it to the attendee’s families?  

On another item for the conference, the Executive Board 

approved paying $20.00 of the registration fee to the 

conference. If you register before May 31st for $70.00 

(early bird) and show John Kennedy your receipt, he will 

write you a check for $20.00.  Registration is online at: 

      http://ohiomidwest.apcug.org/registration.htm
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General Meeting Notes

March General Meeting Program

Ron Sherwood and John Kennedy 

presented another one of their 

“famous” presentations called “More 

Free Software You Gotta Have”. 

 Both Ron and John feel that there 

are many good software packages 

available, for free, that will meet your 

everyday needs.  They recommend 

you give these free programs a try 

and if your needs aren't met, consider 

using a non free program which 

meets your needs.

Ron began demonstrating a program 

that will capture (take a snapshot of) 

your computer screen so that you can 

save and maybe share it with others. 

 The program name is “GADWIN 

PrintScreen”

http://www.gadwin.com/printscreen/

After you install the program, you 

press the “print screen” key. Several 

options are available permitting the 

capture of; the entire desktop 

displayed by the monitor, a window 

on your desktop, or a section of 

desktop which you “box out” with 

your mouse.  When you have 

captured the screen it is saved in the 

clipboard permitting it to be; pasted 

into another document, saved as a 

graphic file (like a .jpg) or sent to 

someone as an attachment.

One great use Ron has found is the 

ability to record changes to setup or 

customization screens.  When testing 

new program setup/customizations, he 

creates a visual record of the previous 

settings.  He is able to easily return 

to the original or previous setup 

without relying on incomplete or 

confusing handwritten notes.

John then shared how to create and 

use an on-line calendar.  He likes to 

use the calendar provided by Google.

http://www.google.com/calendar/render

?hl=en&tab=wc

Google calendars may be accessed, 

by password, from any computer on 

the internet.  You may also create 

multiple calendars and he has 3 

different calendars within his original; 

one for family activities, one for 

activities with friends, and one for all 

his LCCS activities.  The calendar 

may be color coordinated, with each 

group (family, friends, LCCS) 

displayed on the calendar in a 

different color.  You can set up these 

calendars for sharing with others.  As 

an example, grandma and grandpa 

can create a calendar entry and allow 

their children and grandchildren 

access to add all their activities. Now 

the grandparents can see what all is 

happening in the family.

Continued on next page -->

2



VOLUME 22 ISSUE 2, 2009

General Meeting Notes

Another program that Ron finds very 

helpful is called “TreeSize”

http://www.jam-

software.com/freeware/index.shtml

Whereas in Windows Explorer (not 

Internet Explorer), you are able to see 

the size of a hard drive (how much is 

used and how much is free) or file 

within a drive; it lacks the ability of 

telling you anything about the folders. 

 You would have to click on each 

folder to find out how big it is and 

how many files it has.  With 

TreeSize, all that information is 

shown on the display screen.  One 

good use for this program is when 

you might be wanting to fill up a CD 

or DVD with files and folders.  You 

will easily know when you have 

reached the size limits of those 

medias.

As we returned to John's computer, 

he next dealt with PDF (Portable 

Document Format) files.  These are 

the most common type of files found 

on the Internet and are very good 

because just about anyone can open 

them.  All that is needed to open and 

read a PDF file is a reader, and John 

recommends “FoxIt Reader”

http://www.foxitsoftware.com/downloa

ds/

This program not only lets you 

“read” the file, it will also let you do 

some editing of it as well.

If you happen to have a file that you 

want to share with someone, and you 

want to be sure they can open it, 

you'll want to convert it to PDF. 

 John's preferred program to convert 

files to pdf is the Open Office suite 

(Writer, Calc, Impress) as they all 

come with a PDF converter included. 

 You open the file in Open Office, 

click the menu items File>Export as 

PDF, and then Export (save it) it to 

the desired location.  Now you can 

attach the file and send via e-mail or 

copy to portable media.

If you don't have Open Office 

installed (free),

http://download.openoffice.org/

you might want to try another free 

program to “print” the file to PDF. 

 The term "print" is misleading 

because you're not truely printing 

anything, you are converting and 

saving a file in pdf format.  Installing 

“PDF Creator”

http://sourceforge.net/projects/pdfcreato

r/

creates a virtual (not real) printer that 

you can choose, instead of your 

normal printer, when you go to 

“File>Print”.

Continued on next page -->
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Finally, you might want to merge a 

number of pdf files so you have only 

one to save/send or you might want 

to save just a portion of a large PDF 

file.  Here's a program for that task, 

called “PDF Split and Merge”

http://www.pdfsam.org/?page_id=32

Make sure you do not get the “alpha” 

version. You want the first one under 

Basic (not Enhanced, which has a 

cost associated with it).  After 

installation, you just follow the 

instructions.

FOLLOW-UP NOTE: Ron had 

problems opening some PDF files 

with this program. They appeared to 

be “locked” and couldn't be merged, 

so he searched for another free 

program.  He found

(http://www.adolix.com/split-merge-

pdf/)

didn't have the problem.  It is 

recommended that you give this one 

a try.

The final program that Ron 

demonstrated dealt with finding 

duplicate image files on your 

computer.  There are many LCCS 

members who take pictures, edit them 

and create improved versions or 

somehow end up 

copying/downloading the same 

pictures to different locations.  The 

program “VisiPics”

http://www.visipics.info/index.php?title

=Download

searches your folders (you tell it 

where to look) listing the pictures 

found which match perfectly or seem 

to be a very close match.  It 

evaluates the information in the 

image file instead of the file name. 

 When finished, it allows you to 

mark the image(s) you want to keep 

and those you want to remove.  Very 

helpful if you have pictures/images 

stored in several locations.

      News from APCUG

AUGUST APCUG NEWS

Robert Vance has provided a tentative schedule of events for the August 

APCUG (Association of Personal Computer Users Group) meeting.  The size 

and shape requires a landscape layout on the next page.  Bob has worked 

many hours to pull this together and it looks to be a very nice payoff for us. 

 The meeting should be a good opportunity for us to get first hand technical 

information about personal computers.  Typically, there are software handouts 

in addition to door prizes and other swag.
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      News from APCUG

Conference information:

http://ohiomidwest.apcug.org/

http://ohiomidwest.apcug.org/registration.htm

http://www.cherryvalleylodge.com/
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Linux SIG

Linux SIG – March 15th

For this meeting, we had a 

presentation by Ken Bixler.  He 

demonstrated the use of his Linux 

computer to manage electrical devices 

around his home.  A master 

controller is plugged into the 

electrical system.  The computer is 

connected to the controller via an 

ethernet cable allowing unattended 

cycling of devices.  Wireless remotes 

can override commands as needed. 

 Different types of modules attach to 

receptacles, screw into light sockets 

or are installed in place of standard 

switches and receptacles.  Light bulbs 

can be screwed into a plug that 

screws into the socket, or lamps can 

be plugged into receptacles that plug 

into the wall (or anything else that 

can be plugged in).  Some of the 

devices operate wirelessly with the 

use of remote controls.    Each unit 

is coded with an address, which may 

or may not be the same as others.  If 

you want the porch and garage lights 

to come on and off together, you use 

a common address.  These 

“hardware” devices may be ordered 

from X10.com or several other 

sources.

Computer software (such as “heyu”) 

is configured to turn on/off each of 

the different devices according to 

their coding.

Differing from some “old fashion” 

timers that are used to turn devices 

on and off once (or maybe twice) a 

day, the computer program can be set 

up to turn things on and off any 

number of times per day.  The 

controller can be set up to operate 

devices at different times on different 

days of the week and any day up to a 

year in advance.  Ken explained that 

it's possible to set things up so that if 

the doorbell rings, a recording of a 

dog barking can be heard.  Another 

function allows a video camera to 

activate on motion or a video camera 

may be accessed and activated via the 

computer and Internet to see what's 

going on inside or outside.

You have to purchase the hardware, 

but the software that makes this all 

work is, as always with Linux, free.

We finished up the SIG meeting 

discussing a few terminal commands. 

Members are trying to learn more 

about working within the Linux 

terminal using text commands.  It has 

been asserted that having a good 

understanding of commands allows 

you to perform tasks in Linux faster 

than you could using the mouse and 

all the menu systems.
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Linux SIG – April 5th

Today's SIG began with a discussion 

of software installation.  One way to 

install software is through the 

included “Synaptic Package Manager” 

and another is via 

Applications>Add/Remove (both list 

the certified software in repositories 

for Debian based Linux).  There may 

come a time when you find a piece 

of software that hasn't yet been added 

to the repository.  You then 

download the program and install it 

yourself.

The easiest type of file for Ubuntu 

users is the .deb (Debian) extension, 

as that is the framework for Ubuntu. 

 When you double click this type of 

file, Ubuntu knows exactly what to 

do and performs the installation 

automatically.  A second type of file 

(.rpm) that is used by a number of 

different versions of Linux, such as 

Suse, RedHat, Puppy, etc has the 

.RPM extension.  This is a little 

different, requiring you to run the 

Yum program or run a simple 

conversion command in the terminal.

Occasionally you find a program that 

you want to use which has not been 

“packaged” to automatically install. 

 These program files may have the 

.tar.gz or .bz extension.  If so, it is a 

compressed (zip) file that first has to 

be decompressed (unzipped), then 

compiled.

Compiling uses a terminal command 

sequence to execute, which was the 

second part of today's SIG, learning 

more terminal commands.

For those who are intimidated by the 

command line, compiling might be 

too much “programming” and you 

might be better off waiting for the 

“package” to be added to the list 

Synaptic Package Manager.  After 

packaging it becomes just a few 

clicks of the mouse – no need to use 

terminal commands.  But for some it 

would result in the satisfaction of 

having built a piece of software from 

the ground up.  Be aware that 

software will never be added to 

repository for various reasons.

Editor's note: My wife has yet to find 

a program need which is not covered 

by repository.  Most common 

Windows programs have 

complimentary Linux programs 

available.

Linux SIG
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Linux SIG

Linux SIG April 5th

Robert Vance continues to modify 

obsolete “Macs” to be Ubuntu Linux 

machines for distribution.  They are 

the colorful macs with everything 

built into the monitor case.  The hard 

drive, video card and all input/output 

ports are built in.  The keyboard and 

mouse being the only thing you need 

attached to the monitor.

Two other members explored the 

world of the command line on a 

Ubuntu operating system.  You are 

able to type  commands directly into 

the system for control and 

programming.  A similar function 

exists in Window as the “Run 

Command” window, but Linux 

permits much more control.

For example:  You are working on a 

family tree project, you really enjoy 

it and you are losing track of time. 

 Someone important to you is 

expecting you to show up at Miller's 

for super and THEY ARE BUYING! 

 In windows you have to open an 

application, type in several entries, 

then save everything so a message 

will pop up at an appropriate time. 

 In Linux I click on the Terminal 

icon and type “at -f 'get up' HH:MM. 

 At the appointed time the file “get 

up” will speak the phrase “Get up 

Ken.”

In fairness I created the “get up” file 

using "espeak" but that was one time, 

a year ago.  If you like, you can 

paste entire pages of print into the 

single quotes and the page will be 

read back to you.  Many options are 

available for voice and gender.

Want to know how many teaspoons 

are in a barrel?  Type “units” then 

enter “tsp”, “barrel” and it displays 

3.1001984e-05, which is 310,019.84 

teaspoons in a barrel.  Need the 

square root of 67389?  Type bc, 

sqrt(67389 ), hit the enter key and 

259 pops out.  On my computer you 

can type “vlc Music/e_rigby.mpg” 

and Elenore Rigby plays, as will any 

song title from my playlist when you 

enter the file name.

Ken Bixler updated a computer to 

Ubuntu 9.10 in preparation for 

installing Virtual Box and several 

other Linux distributions.  Virtual 

Box allows a second complete 

computer to exist electronically inside 

your primary operating system.  With 

Virtual Box or VMWare, Windows 

XP can have Linux running "inside 

XP" simultaneously, only a couple of 

keystrokes away.  If you want to 

explore Linux without giving up 

Windows you'll have to come to a 

meeting to see how it's done.  Did 

we mention that Linux is 

FREE...John loves that.

8



VOLUME 22 ISSUE 2, 2009

Repair SIG – April 7th

You could tell that it was spring as 

we had a number of computers that 

must have come out of hibernation. 

 In fact we probably had a record 

number of units brought in.  The 

only difficulty was the ratio (3:1) of 

problem computers to repair people. 

 It became a very long night and not 

everyone went away with a repaired 

computer.  In fact, one repair person 

planned to return Saturday to 

complete his last project and another 

repair person took a computer home 

to finish, as it was going on 11:00 

p.m.  Several of the computer 

problems were not a quick fix.  One 

of our biggest problems involved 

missing drivers which weren't 

available on disk.  Of course, it was 

frequently the drivers that permit 

Internet access that were missing. 

 Obtaining network drivers meant we 

had to go to one of the A-Frame 

computers that was on-line, find the 

driver we needed, download it to a 

USB thumb drive, and install it on 

the broken computer.  When the 

defective computer could finally 

access the Internet, we were able to 

directly download the additional 

drivers for sound, video or other 

devices.

A few of our “problems” included:

-A computer which couldn't access 

the internet through the dial up 

modem, but  could access the Internet 

through the network card.  The owner 

has a dial-up service at home, so we 

had to set the dial up modem.

-Another was a laptop that previously 

had a Linux OS installed, but because 

it couldn't play some Windows games 

the owner tried to reinstall Windows 

and failed.  Having misplaced their 

installation code our only option was 

to reinstall XP using our MARs 

software.  We then faced a problem 

wireless connection, which we were 

not able to repair because windows 

couldn't detect the wireless modem 

card.

-One other computer required a 

replacement hard drive and 

reinstallation of the OS.

A special thanks goes out to the 

“overtime” repair guys for staying the 

extra hours or even beyond.

Repair SIG
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Repair SIG – April 26th

Jim Amore

A MAR (Microsoft Authorized 

Refurbisher) computer owner 

complained about poor sound output. 

 I checked the motherboard and 

finding no damage, located the 

onboard sound output jack.  Next, I 

considered trying to find updated 

drivers.  That sounded like too much 

work, so I just installed a different 

sound card.  It was a Sound Blaster 

ISA card we had obtained at one of 

the  recycling events.  Opening the 

Device Manager, intending to disable 

the old sound card, I found 7 sound 

related items.  Not being sure which 

item to disable, I installed the new 

software along side the 7 other 

versions.  XP found and installed all 

the drivers so I connected the internal 

cables for the CD-ROM’s and 

speakers to the new card.  When I 

tried a sound test nothing happened. 

 As an afterthought, I tried the 

external speakers by connecting to 

the old sound output jacks, which 

worked great.  Even the CD-ROM’s 

that are hooked up to the new card 

sounded great. So, I put tape over the 

new card output jacks and told the 

owner it was fixed.  Sometimes you 

just stumble on a repair.

I have another repair project I’m 

working on.  A friend bought a 

computer at Best Buy, who backed 

up her utilities, but not the operating 

system.  The hard drive eventually 

crashed, so a new hard drive was 

installed.   She put a new installation 

of Vista on the drive but didn’t 

activate VISTA before the software 

timed out and quit working.  She has 

ordered a restore CD ($20) for her 

system but is concerned that she'll 

lose her documents and pictures when 

VISTA is restored.  The new hard 

drive is 320 GB and SATA which 

made backing it up a problem 

because we don’t have equipment 

new enough to handle SATA at the a-

frame.  I decided to try a Ubuntu live 

CD to see what was on the hard 

drive and possibly back up files 

through linux.  Sure enough, I was 

able to see all her files and pictures. 

 The next problem was finding a file 

save location.  I was able to use the 

Windows Home Server to save some 

files but the drive filled up quickly, 

unable to complete a full back up of 

her system.  I plan to purchase an 

external USB backup drive for adding 

disk memory to the server.   The 

external drive will have enough 

storage space to finish saving the 

files, which will then be restored 

after her computer has VISTA 

reinstalled.

Repair SIG
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Mary Francis suggests tabbed 

browsing for increased productivity 

and many others agree with her.

She suggests 

http://www.komando.com/

as a reference.  I believe you must 

join the komando website to view the 

material, which is copyrighted.

Current information for Firefox 

tabbed browsing may be found here:

http://kb.mozillazine.org/Category:Tabb

ed_browsing

Although the documents reference 

Firefox, the information is relevant to 

most other browsers.

Mary Francis has also fielded 

questions about the toolbars at the top 

of the browser page.  Specifically, the 

questions are in regard to removal of 

the toolbars.  Removal isn't 

something easily done but hiding is 

effective.  Go to the menu items 

View>Toolbars and check/uncheck 

the bars as desired.  A check mark 

means the bar will be displayed.

LCCS Members Speak

Club member/Officer is a celebrity

Quoted from the Newark Advocate

Jeffrey “J.C.” Deck will do something this spring that doesn’t happen often.

He’ll receive his high school diploma in May, then get his associate degree 

from Central Ohio Technical College in June.

Deck, 18, was homeschooled through eighth grade, then enrolled in Southwest 

Licking Local Schools’ Digital Academy at 15 so he could take Post 

Secondary Enrollment Option classes at COTC, where he majored in electronic 

engineering technology.

“He’s the first I’ve had who’s done what he’s done,” assistant professor 

Richard Romei said. “He was able to deal with the fact that there was a 

maturity (he needed to have). After the first quarter, he was just another 

student.”

Tabbed Browsing & Toolbar Removal

Mary Frances Rauch
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Speakers and Events

!!!POT LUCK PICNIC!!!

JUNE 20th

On June 20th we will have a pot luck picnic at the A-frame on Cherry 

Valley Rd.  We will begin the afternoon with our normal repair SIG at 

1:00pm.  When finished, probably around 4:00pm, we'll bask in the sun 

before the picnic at 6:00pm.  Dinner will be hamburgers, hot dogs, brats 

and chicken breast.  The meat, buns and pop will be provided.  Please 

bring lawn chairs and/or food to share.
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WELCOME NEW MEMBERS

January through February, 2009

Nancy Allee

Bonita Brands "Bonnie"

William Buxton

Mary L. Craig

Bobbie Dornhecker

Fred Davis

Ronna Eagle

Fatina Evans

James A. Holliday

Kristopher Kasson

Eydie Keim

Timothy A. Ward

William Wheeler

Shane Wilson

RENEWING MEMBERS

January through February, 2009

Carl E. Bratfisch

Earl A. Browning

Charles Clarke

John & Bonnie Daley

Catherine & Wayne 

Eddleblute

Lewis Hullingar

John Kennedy

John Koenig

Idabell Koontz

Baxter McCanna

Dick Riley

Ron Sherwood

George Willey

Harold Williamson

Current members will receive a postal mail notice with a 

prorated dues billing.  This is an effort to get everyone 

on a common due date.  A complete explanation may be 

found online in the Forum.
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Licking County Computer Society, Inc.

PO Box 612

Newark, OH 43058-0612

LICKING COUNTY COMPUTER SOCIETY 2009

President:

Jim Amore        404-3963 President@lccsohio.org

Vice-president:

Kemp O'Dell     348-0049 Vicepresident@lccsohio.org

Secretary:

J. C. Deck         unlisted Secretary@lccsohio.org

Treasurer:

John Kennedy   348-5229 Treasurer@lccsohio.org

Trustees:

Mary Frances Rauch 522-4710 Trustees@lccsohio.org

George Hreha 740-924-1925 Trustees@lccsohio.org

Vicky Atkins     349-8048    Trustees@lccsohio.org

Past President:

Don Furnish     927-9753 DonlFurnish@copper.net

Newsletter Editor:

Ken Bixler  403-1229 newsletter@lccsohio.org

APCUG Representative:

Robert L. Vance 779-3218 vanleer@horizonview.net

Agent:

David Bibler     345-3492    Agent@lccsohio.org

Information Director:

Vicky Atkins     349-8048    vmatkins@alink.com

Teaching Program Chairman:

George Hreha 740-924-1925 ghreha@columbus.rr.com

Meeting Programs Director:

Kemp O'Dell     348-0049 Vicepresident@lccsohio.org

Dave DeRolf                 dderolph@embarqmail.com

Membership Chairman:

Vicky Atkins  349-8048 vmatkins@alink.com        

LCCS/LCAP Seniors Classes:

Dave Bibler    345-3492 lcap@lcap.org

Recycling Events Chair:

Jim Amore        404-396 President@lccsohio.org

Refurbish and Recycle Chairman:

Vacant

Webmaster:

Jon Luzio        587-4632 Webmaster@lccsohio.org

Digital Imaging SIG:

Dave Clement   unlisted dvclementusa@yahoo.com

Linux SIG:

Jim Amore      404-3963 President@lccsohio.org

MS Works/Word SIG:

Mary Frances Rauch522-4710 rauchhouse@alink.com

Networking SIG:

Kemp O'Dell    348 0049 kemp@odellhome.com

Novice SIG:

George Willey  788-8484 gwilley@alink.com

Repair SIG:

Wyn Davies     366-6314 aeolus@windstream.net

WebSIG:

Kevin Clement 587-1511 clementk777@gmail.com
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